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General information  

 

How does the Gutenberg Research Elements project schedule look like? 

In the summer of 2018, the concept phase (including clarification of responsibilities, 

creation of a project structure plan and definition of the databases) began, followed 

by the preparation and the test phase (including information and communication with 

the institutions and projects involved in the project, installation of the software, 

preparation and implementation of short training courses and providing information to 

the deaneries and the senate). After this block was completed in November 2019, the 

pilot phase began in the 2019/2020 winter semester in faculties 08 and 01. 

We are currently in the implementation phase. The data generation (information, data 

preparation, data coordination and content filling of the software) of all departments 

and the establishment of a "help desk" takes place. In the winter semester 2021/2022, 

a system of research reporting will be established, which includes the consolidation 

of the report-relevant data in the JGU data warehouse as well as the creation of basic 

reports and the development and provision of key figures. 

What is Research Information? 

Research information is metadata which provides information on the research activity 

of individual researchers as well as entire research institutions. According to the 

German Core Data Set, information on employees and doctoral students, as well as 

on publications, grants and research prizes and awards is included. 

The term research information must be differentiated from the term research data, 

which refers to the direct output created by research activity. For more information 

regarding research data and research data management at JGU, please click here. 

What is the German Core Data Set (Kerndatensatz Forschung, KDSF)?  

The German Core Data Set (Kerndatensatz Forschung, KDSF) is a national standard 

developed in order to harmonize the collection and maintenance of research 

information in the German research system. The Spezifikation des Kerndatensatz 

Forschung (Specification of the German Core Data Set, version 1.0, link in German) 

was drawn up after a three-year project phase and was recommended for 

implementation in the German research system by the Wissenschaftsrat in January 

2016. 

 

https://researchdata.uni-mainz.de/informationsmaterialien/
https://www.kerndatensatz-forschung.de/index.php?id=spezifikation
https://www.kerndatensatz-forschung.de/index.php?id=spezifikation
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What is a Current Research Information System? 

Current Research Information Systems are web-based software solutions which 

serve to record and collect research information, as well as support individual 

researchers’ work processes and extend and construct university-wide research 

reporting. 

You can find further information on the introduction and function of Current Research 

Information Systems in higher education institutions and research institutes in 

the DINI AG FIS position paper (link in German). 

What is Gutenberg Research Elements? 

Gutenberg Research Elements is JGU’s Current Research Information System. The 

software allows researchers to always have an overview of their own research 

activities, connect with colleagues within JGU, and use the collected information for 

various purposes (support when applying for grants or allowance, portrayal of own 

research achievements on personal websites, etc.). 

What is the main benefit for individual researchers? 

In addition to general functions such as: 

• Individually configurable and automated integration of metadata from external 

bibliographic data sources 

• Import of publication lists 

• Presentation of research activities on Research Profiles, the public profile 

page of Gutenberg Research Elements. 

• Connecting publications with every involved author and other databases 

(grants, research awards, etc.) 

• Personal management tools requiring minor manual acquisition effort 

• JGU-internal research tool 

• Independent data upkeep when using the delegation function 

• Export of research information for different purposes: Support when applying 

for grants, allowance, searching for cooperation partners, applying for 

reassignment of professorships, documentation of one’s own research 

achievements, informational basis for faculty reports, etc. 

the main benefit is the automated integration of publication lists from personal 

websites and faculty or institute homepages. 

https://zenodo.org/record/14828#.Xg3_jv9Ya71
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What were the reasons for acquiring a commercial product?  

The German Council of Science and Humanities (Wissenschaftsrat, WR) points out 

that systems established on the market have a number of advantages regarding their 

operation, maintenance, and expansion possibilities when compared to programs 

developed in-house. Furthermore, internal factors such as the lack of capacity for the 

development of such a program at JGU also played a role. After comparing the 

software solutions available, university management agreed to follow the 

recommendation from the University Library (UB) and the Data Center (ZDV) to 

purchase the software. 

The software solution Symplectic Elements allows for extensive network creation 

and automation of data acquisition. 

What kind of research information can be collected?  

Currently, Gutenberg Research Elements can collect and connect information on 

publications and patents (Publications Module), grants from MACH (Grants Module), 

as well as distinctions (Professional Activities Module). 

What Information is visible for other users?  

Before you log in for the first time, your profile will only appear in the system with your 

name. Only when you have actively adjusted your search settings and / or 

independently added publications, third-party funded projects and other research 

information to your profile this information will appear on your profile page for other 

people to see. Via 'Edit your profile' on the welcome page you get to the edit mode of 

your profile page. Here you can introduce yourself with a short text, your previous 

experience and a photo. With a click on 'View profile' you can view your own profile 

as it is visible to other Elements users.  

In Research Elements itself, your profile is only visible internally. In addition, Research 

Profiles offers you the possibility to make your scientific activities and publications 

visible on a public profile page. 

 

Of course, you can decide yourself whether you want to make your profile page 

publicly visible (see FAQ – Research-Profiles: How do I set my profile to ‘public’ so 

that I can use Research Profiles?) and which of your research activities from 

Gutenberg Research Elements should be included in the profile page. 

 

https://www.symplectic.co.uk/solutions/theelementsplatform/
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How can I control what information is visible in Gutenberg Research 

Elements? 
There are two types of information in Gutenberg Research Elements where the 

privacy settings can be customized by the user: The information on your profile page 

in Gutenberg Research Elements and your relationship with the publication. 

 

How can the information in the user profile in Gutenberg Research 

Elements be set to private? 
The following information is recorded in your Gutenberg Research Elements user 

profile: name, department, email address, phone number, and information about your 

CV such as research interests and educational qualifications, if you include them in 

your profile. If your profile in Gutenberg Research Elements is set to public, this 

information is visible in your public profile in Research Profiles. However, there is a 

way to make individual informations not visible to other users. To do this, click on 

"Switch to edit mode" in the upper right corner. If you click on the "edit" button next 

to the fields, you can not only edit the content, but also set this field to "private", so 

that this information is no longer visible. Almost all information can be set to "private" 

except for the name, department, ORCID ID and a work email address. These settings 

can be undone by changing the information to "match profile level".  

 

How do I search for an entry?  
In order to search for an entry, please open the drop-down menu on the left above 

and select “Reporting” → “Search” and “System Search”. 

For example, if you know the title or reference number for a grant project, you can 

enter that information in the search window. For a broader search, choose the 

‚Advanced’ search option. You can limit your search step by step and view entries to 

different research information. Don’t forget to check the box for ‘Johannes Gutenberg 

University Mainz’ before beginning your search. 

How do I search for colleagues? 

On the left panel of the window, select the "Profile" button. There you will be directed 

to your profile page. With the feature "Find a colleague" you can search for colleagues 

who are employed by the JGU. Another way to search for colleagues and find their 

profiles is Research Profiles. You can find more information here: 

https://researchprofiles.uni-mainz.de/  

https://researchprofiles.uni-mainz.de/
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I noticed some strangely formulated texts on the Gutenberg Research 

Elements website. What can I do? 

It can happen that on some browsers texts on Gutenberg Research Elements or on 

other websites are displayed in a rather clumsy sounding German. This may occur 

when using Microsoft Edge or Google Chrome. 

Such strange wordings are usually the result of the automatic translations of your 

browser. You can easily configure your language settings on your browser to avoid 

this. How to do this in Microsoft Edge is explained as follows. 

1. Please open the settings via the three dots placed next to each other. 

Alternatively, you can use the key combination ALT + F. 

2. Now select "Einstellungen". 

3. In the new window, click on "Sprachen" on the left side of the screen. 

4. Under the category "Bevorzugte Sprachen", set off the option "Anbieten, 

Seiten zu übersetzen, die in keiner von Ihnen gelesenen Sprachen 

verfügbar sind" to deactivate the automatic translation function. 

 

How do Networks work in Research Profiles? 
In Research Profiles, we have a feature that visualizes collaborations on joint 

publications between users of Gutenberg Research Elements. This graph is designed 

to make it easier to navigate between profiles, especially when the collaborations are 

cross-domain. Users of Research Profiles can interact with the diagram, exploring 

each researcher's cross-departmental collaboration network. Clicking on any of these 

nodes displays more information about each researcher, including a link to their full 

Research Profiles profile. By hovering over a node, you can view the connections 

between each researcher and their collaborators in the diagram. 

You can toggle between the researcher's direct and extended networks to see only 

the researcher's own co-authors or an extended view that includes those co-authors' 

collaborators. 

The size of the nodes can be resized by clicking on one of the buttons on the right, so 

that they represent the number of collaborations the researcher shares with other 

researchers in the diagram. In addition, the total number of outputs/publications of 

each researcher (without "private" publications) or the degree of separation between 

researchers belonging to the network and their collaborators can be displayed.  
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Hovering over a group on the Department Key will highlight which researchers are 

assigned to that department. Finally, each network diagram is generated based on 

the publications associated with the researcher's profile within their profile in 

Research Profiles (i.e. it excludes unclaimed publications as well as publications set 

to "private").  

The diagram is enabled for all researchers who have two or more collaborators or 

collaboration partners with public profiles in their Research Profile. 

 

Access and Sign-Up 

 

How do I get access to the portal? 

Signing up for Gutenberg Research Elements can be done in the university-wide 

network without log-in data. In other cases, you might need your JGU account, which 

is automatically created for university employees (without requiring an application). 

Who has access to Gutenberg Research Elements? 

Direct access for the following people (or accounts): 

• University employees 

• PhD students 

• retired professors 

 

Access after activation on your own account page, so that e.g. publications can be 

managed on behalf of employees: 

• Students 

• Research Assistants 

 

Currently no access to the system possible: 

• Employees of the university medicine 

• External institutions (e.g. Institute for Molecular Biology/Helmholtz 

Institute/IEG) 

 

Link for signing up 

You can reach Gutenberg Research Elements’ log-in page here. 

https://researchelements.uni-mainz.de/
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What do I have to take note of when first signing up?  

The following steps are recommended for initial registration in Gutenberg Research 

Elements: 

• Step 1 (optional): Add ORCID 

• Step 2: Set up search settings 

• Step 3: Run my searches 

These functions are always accessible using the menu on the left above: “My 

Account” → “Data Source Search”. 

How can I transfer user rights to another person?  

Elements possesses a delegation function you can use to transfer certain tasks to 

one or more individuals. You can transfer tasks to one or more individuals. To do this, 

select in the drop-down menu on the left above "My Profile" →  "Settings" → 

"Manage delegates". Now you can enter the name of the person to whom you want 

to transfer user rights in the new window under "Manage delegates" → "Add 

delegate". 

The person you have selected automatically receives a copy of your Elements 

notifications and can manage and change your Elements account for you. 

Is it possible to delegate tasks to secretariats and research assistants?  

Secretariats – as well as all employees of JGU – have automatic access to the portal. 

For this group of people delegation of tasks is unproblematic. 

Research assistants who only have a student account do not have automatic access 

to the portal. 

To take over tasks in Gutenberg Research Elements, students need to add the 

feature “Account in Symplectic Elements aktivieren” (Activate account in 

Symplectic Elements) on the website www.account-uni-mainz.de. Due to 

overnight activation, the functionality will be only available the following day. 

You will find notes about the delegation of tasks under the question: “How can I 

transfer user right to another person?“. 

How can I edit publication data on behalf of someone else?  

Gutenberg Research Elements has a delegation function with which the data 

maintenance can be delegated to you by one or more other persons. You can access 

the input masks for people who have given you data maintenance via the 

“Impersonate” button. You will find the "Impersonate" button in the top bar (the left 

https://account.uni-mainz.de/
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symbol with two people and a key) if you have been activated by someone as a 

delegate. In the new window you will find a text field under “Impersonate another 

user” in which you can enter the name of the desired person. If this person has 

transferred the user rights to you, you can now access their profile. 

What does the assignment to a primary group mean? 
As far as it is possible due to existing data, the user accounts in Gutenberg Research 

Elements are each assigned to a primary group. Currently, this is usually the 

department level (or comparable). This assignment is done automatically via a data 

import from your JGU account and is displayed on your profile page under "Primary 

group". The primary group also serves as a filter option in Research Profiles for 

publicly visible profile pages.  

For publication entries, a more detailed assignment to organizational units on lower 

levels is possible, which you can also change afterwards (see FAQ Publication entry 

- Assignment to organisational units). 

 

Integrating Publications 

 

Structure and use of the Publications list 

What is the difference between the Pending List and the Claimed List?  

You can use the Pending List in order to claim or reject publications suggested to you 

with the name-based search. Then, the publications move to the ‘Claimed‘ or 

‚Rejected‘ List. It is therefore possible to clear up your Pending List should many 

inaccurate publications be suggested to you based on your name. Publications 

already in the system because they were found on other publication lists will always 

appear in your search results, unless you move them to the ‘Rejected‘ List. 

How to switch publications to invisible? 
Publications can't be set to invisible in Gutenberg Research Elements. The publication 

will be discoverable in the system as well as the relationship status but it is possible 

to set whether the publication will be displayed in your profile in Gutenberg Research 

Elements and the public profile in Research Profiles. There are two ways to do this: 

You can already set when entering the publication whether your role should be visible 

for the entered publication and the publication should show up in your profile. To do 

this, click on "internal" under "Relationship privacy". However, it is only possible to 

select the privacy settings when manually entering publications. If publications 

originate from external data sources, these must first be claimed and the relationship 

https://researchinformationsystem.uni-mainz.de/faq-integrating-publications/#collapse1
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status can then be edited there. This is also possible for publications that have already 

been entered: under "My Publications", click on the globe icon located in the right 

margin of each publication entry. In the following window, you can set the relationship 

privacy to "private" (only you will see the publication) or "internal” (only users in 

Gutenberg Research Elements will see the publication). If a manual publication entry 

is added to an existing publication, no privacy settings can be made in the edit screen. 

Even if manual publication entries are claimed and edited by another user, the privacy 

settings do not appear in the edit screen. 

Which search and filter options do I have in my publication list?  

Especially in the case of extensive publication lists, it is practical to use the search 

and filter options offered by the system. 

To filter your publication list according to certain aspects, first select the full view of 

your publications in the drop-down menu on the left above under “My Profile“ → “My 

Work” → “Publications“. On the right side next to the list, an input area with different 

filter options is displayed. 

  

Filter Effect 

Publication type 
Reduces the list to one or more selected publication 

types such as Artefact, Book, Book chapter etc. 

Relationship type 

Only publications for which you have entered the 

corresponding relationship(s), e.g. Author of, Editor 

of, under the links will be displayed. 

Title 

Only titles in which the entered title keywords occur 

are displayed. The search is performed in the 

displayed list with all filters set. 

Reporting date 
Only publications that appeared in the period you 

entered will be displayed. 
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Label 
Only publications which you have marked with a 

"label" will be displayed. 

Favourite Status 
Only publications which you have declared as 

"Favourite" or "Not favourite" will be displayed. 

Relationship privacy 

Only publications for which the relationship privacy 

is set to Public, Internal or Private are displayed. 

This filter is currently not supported in Gutenberg 

Capture. 

Publication Status 

Only publications whose status is None, Accepted, 

In Preparation, Published, Published online, 

Submitted or Unpublished will be displayed. This 

filter is not currently supported in Gutenberg 

Capture. 

Journal 

Only publications containing the keywords entered 

for the name of the journal in which they were 

published are displayed. The search is performed in 

the displayed list with all filters set. 

Repository Status 

Filters the list of publications by repository status. 

Therefore, only publications that match the 

Deposited, Not Deposited, or Awaiting Deposit facet 

are displayed. This filter is currently not supported 

in Gutenberg Capture. 

OA Policy 

Only publications that comply with the "Institutional 

Policy" are displayed. This filter is currently not 

supported in Gutenberg Capture. 

File available at external source 

Only publications which are available in external 

databases in various gradations - Any, Available, 

Not Available - are displayed. 
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Acceptance date 

Only publications that were accepted in the time 

period you entered under "choose date range" are 

displayed. This filter is currently not supported in 

Gutenberg Capture. 

Publication date 

Only publications that were published in the period 

you entered under "choose date range" are 

displayed. 

Author count 
Only publications with >5, >10, >20, >50 or more 

authors are displayed. 

Can I edit the publication data on the Claimed List? 

In order to adjust the bibliographical data of specific publications to fit your individual 

requirements, you can edit them. 

To edit the publication data in the Claimed list, go to your list of publications and select 

the relevant title by clicking on it. In the field displayed under "Data sources" you can 

create a manual record, if you aren't content with the publication data from an external 

bibliographical database. Click on "Add manual record" to adjust the data in the 

following window according to your preferences. 

How can I edit the Pending List?  

As soon as you have started the search for publications in the selected databases by 

clicking “Run my Searches” or an automatic update was carried out, the publications 

found for you appear on your Pending List. You can claim individual publications as 

your own with a checkmark or reject them using the “X”-symbol. Publications you 

confirm move to the Claimed list. Rejected publications move to the ‘Rejected’ list and 

will not be suggested again in subsequent searches. Please note, however, that only 

previously manually created entries can be changed in this way. 

Can I skip the Pending List and automatically claim publications from external 

bibliographic databases? 

If you enter your individual researcher-ID in your settings, the system can skip the 

Pending List and automatically match publications to your profile. For this, you must 

change the following settings: 

Open the drop down menu by clicking on the three parallel lines in the square at the 

top left. In the following window, select "Automatic claiming" under "My Profile" → 

"Settings". There you find the author IDs (e.g. ORCID, ResearcherID, Scopus ID, e-
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mail addresses) which are suggested to you from your name-based search settings. 

After you have accepted your IDs Gutenberg Research Elements will automatically 

identify the publications matching your researcher ID in the external bibliographic 

databases and transfer them to your Claimed list. The precondition is that your 

researcher ID is linked to the publications in the databases. 

What to do when my pending list is empty?  

If you do not find any publications on your pending list after completing your personal 

search settings, please contact support via the following functional mailbox and 

describe your request: researchelements@uni-mainz.de 

Which data sources does the information on publications stem from?  

Information on publications can be integrated in Gutenberg Research Elements 

automatically through different interfaces with external bibliographic databases, such 

as Web of Science, Europe PubMed Central, MLA, ORCID, etc. Additionally, the data 

is adopted from the former university bibliography, as well as JGU’s repositories. 

Furthermore, researchers have the option to enter publication data themselves using 

entry forms or import data from reference management programs (Bibtex, Endnote). 

How does the publication data from Gutenberg Open Science get into 

Gutenberg Research Elements?  

Gutenberg Open Science is the Open Access repository of Johannes Gutenberg-

University and the digital publication record of theses, which are thus made visible to 

scientists worldwide. Gutenberg Open Science replaced the two predecessor 

systems Gutenberg Open and Gutenberg Qualify, whose stored publication data are 

synchronized in Gutenberg Research Elements. 

Automatic synchronization of publication data is regularly performed on Gutenberg 

Research Elements. The transferred publication information is mapped to the 

metadata scheme on Gutenberg Research Elements when it is transferred from 

Gutenberg Open Science. This process may lead to slight differences in the displayed 

publication data, as a different metadata scheme is a basis here. 

The data from the former university bibliography (Metadata UB) and those from 

Gutenberg Open Science (Openscience UB) are visible at “Data Sources”. The full 

texts of the publications can be found under “Full text” in the “Open Science UB” tab 

(if marked with "1"). 

You should only activate the databases in which you expect publication reference. 

Users can also deactivate data sources in the automated searches for the pending 

mailto:researchelements@uni-mainz.de
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list. In the following FAQ "What settings do I have to make to activate/deactivate 

certain data sources in my pending list?" is an instruction on how to do this. 

What settings do I have to make to activate/deactivate a specific data source 

in my pending list?  

Gutenberg Research Elements gives you the option of activating and deactivating 

certain data sources in your Pending List. This selection makes sense, because 

otherwise publications that you have not authored could be assigned to you on the 

basis of name similarities. Therefore, only those databases should be activated in 

which your publications or publications that correspond to your discipline are to be 

expected. 

The following data sources are activated by pre-setting throughout the system: 

METADATA.UB and OPENSCIENCE.UB. Information on these data sources can be 

found in the corresponding FAQ entries. 

To enable or disable data sources, proceed as follows: 

1. In the drop-down menu on the left above, select "My Profile" → "Settings" 

and click on "Name-based Search".  

2. There you can add and remove the data sources in the lower input field, by 

putting in or removing the cross in the box under "Search by Name". 

3. Additionally, you can select either the "Simple Mode" or the "Advanced 

Mode". While the simple mode works with the system's default settings, you 

can modify the search in the advanced mode. To do this, click on the 

downward pointing arrow next to the data source to change the search 

conditions. In the free field that is now displayed, you can type in the desired 

keywords. The "Advanced mode" is not available for all data sources. 

 

What can I do if there are many publications in my pending list that are not 

mine? 

If you see that there are many publications in your pending list that suggest authors 

of your name or one of your names, then you should adjust your search settings under 

"My Profile"→ "Settings"→ "Name-based search". In the "Name-based search" you 

have the following options: You can remove variants of your name, as well as you can 

specify a more precise address, e.g. next to the city also that of the university. 

Furthermore, you can limit the search to a start date, keywords, journals or specific 

IDs of certain databases. It is recommended to deactivate the data sources that are 
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not relevant for you and your research area. To do this, uncheck the "Search by 

name" box.   

What is name-based search in Gutenberg Research Elements? 

Name-based search is a search feature in Gutenberg Research Elements that allows 

you to find publications by a specific name (preferably your own) from selected data 

sources in order to claim and thus capture these publications.  

How can the search settings be configured by the user? 

To configure the search settings, please follow the steps below: 

1. Enter the name to be searched for in the "Name variants" field. Multiple 

names or name variants can be entered to search for in the data sources. It is 

important that you start with the last name when entering and write the first 

name or the first letter of the first name after a comma. 

2. Enter the institution associated with the name in the field under "Addresses". 

3. Ehen add other supplementary search information. These are the start 

date, when the desired results were published, keywords and journals to 

search. Enter the start date in the format "14 Mar 2001 (dd MMM yyyy)", "Mar 

2001 (MMM yyyy)" or "2001 (yyyy)".  

4. You can still specify an Article ID and then the online database in which it 

should be searched.  

5. Now you will see a list of data sources that are searched in Gutenberg 

Research Elements. There are different search modes here, some of which 

can be activated simultaneously, and some of which can be activated 

alternately. 

What are the different search modes? 

There are four different search modes in the list of data sources. These are "Search 

by name", "Simple mode", "Advanced mode" and "Use default search terms". In the 

"Search by name" search mode, the external data sources are searched for the 

specified name or names. When a search by name is performed, the "Use default 

search terms" option can be enabled at the same time. If this option is enabled, the 

default search terms will be used. You can search either in "Simple mode" or in 

"Advanced mode". In the "Simple Mode" the search is done by name and the search 

terms name, address, start date and keywords, possibly also Article ID are used. In 

the database arXiv the "Subject Category" can be selected for the search. However, 

if "Advanced Mode" is searched, the user must actively enter search terms or a longer 

search text into a search field. For this purpose, it is necessary, among other things, 

to create the prefixes provided for the queries in ArXiv (for more information, see: 
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arXiv API User's Manual | arXiv e-print repository. On the databases PubMed 

(Advanced Search Results - PubMed (nih.gov)) and WebofScience (Advanced 

Search Field Tags (clarivate.com) this approach also applies and those who want 

to use the Advanced Mode are advised to inform themselves thoroughly on the 

websites. However, if this is not done and the "Advanced Mode" is selected, the 

search remains resultless.        

Which one-time settings do I have to make in order to receive a list of 

recommended publications for my own profile from external bibliographic 

databases?  

The system carries out a name-related search in the external bibliographic databases 

in order to create a personal list of recommendations: the Pending List. To achieve 

that, you have to change the following settings: 

1. Edit name settings: Your name is automatically set in the search settings 

(usually by last name, first name). To expand the search settings, select in the 

drop-down menu on the left above "My Profile" → "Settings" and click on 

"Name based Search". Your name is automatically set in the search settings 

(usually by last name, first name). Under "Name based Search Terms" you 

can specify name variations (e.g. surname, initials) or address options (e.g. 

Mainz) via the "+" (add) and "x" (remove) symbols and then save your settings 

with "save". A restriction via the address option ("Addresses") is particularly 

helpful if your name has many entries in the bibliographic databases which do 

not belong to you. 

2. Select databases: In the menu under "My Profile" → "Settings" → "Name-

based Search" you will find the corresponding setting options under "Source-

specific name-based search terms". There you can tick the box for the 

required external database and save your settings with "save". 

How do data from the university bibliography get into Gutenberg Research 

Elements?  

Before the introduction of Gutenberg Research Elements, publication information was 

available in many different applications. It was distributed and structured separately. 

One of these applications is the former University Bibliography, which was in 

operation from 2006 to 2020. After the transfer of publication data to Gutenberg 

Research Elements, which began in August 2020, it was switched off, as Gutenberg 

Research Elements, in contrast to the former university bibliography, offers more 

comprehensive publication management. 

 

https://arxiv.org/help/api/user-manual#query_details
https://pubmed.ncbi.nlm.nih.gov/advanced/
https://webofscience.help.clarivate.com/en-us/Content/wos-core-collection/woscc-search-field-tags.htm
https://webofscience.help.clarivate.com/en-us/Content/wos-core-collection/woscc-search-field-tags.htm
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Gutenberg Research Elements adds the publications from the university bibliography 

for which you are listed as author to your Pending List via automatic synchronization 

without the need to start manual searches. Afterwards you only have to add these 

publications to your publication list via the "Claim as mine" function on the Pending 

List. 

For all publications for which you are listed as the editor, you must manually add the 

relevant publications to your list: 

1. Search for the publications by selecting "Reporting" → "Search" → 

"System Search" in the drop-down menu on the left above. Now enter 

the title of the requested publication in the search field.  

2. Go to the detail page of the publication by double-clicking on it. Scroll 

down to the "Links" field.  

3. Enter your name (last name, first name) in the search field. Two drop-

down fields with "Name" and "Relationship" will appear.  

4. Make sure that your name is in the first field and then select the option 

"Editor of" in the "Relationship" drop-down field. Finally, click on the 

mint green "+" symbol to the right to complete the process. In case you 

are looking for a specific publication from the former university 

bibliography, please select "Reporting" → "Search" → "System 

Search" from the menu and enter the title of the required publication. 

A search via the publication ID under "My Profile" → "Settings" → 

"Name based Search" is not provided for records from the former 

university bibliography. 

If you are looking for a specific publication from the university bibliography, please 

select the option "Menu” → “Explore” → “System Search" and enter the title of the 

publication. A search using a publication ID under "My Account” → “Name-based 

search" is not intended for entries from the university bibliography. 

How can I transfer data from the University Library's Open Science 

Repository?  

Gutenberg Open Science is the open access repository of Johannes Gutenberg 

University and the digital publication of dissertations, which are made visible 

worldwide this way. The repository is available in Gutenberg Research Elements as 

a data source with the designation OPENSCIENCE.UB. 
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Gutenberg Research Elements has an automatic synchronization of this data source. 

This synchronization can lead to slight differences in the presentation of the 

publication data since the publication data must be transformed into a different 

metadata scheme when it is transferred. 

Publications for which you are listed as an author are added to your pending list 

without you having to start manual searches. Then all you must do is add these 

publications to your list of publications using the "Claim as mine" function. 

For all publications for which you are listed as editor, you must manually add the 

relevant publications to your list: 

1. Find the desired publications with “Reporting” → “Search” → “System 

Search” from the drop-down menu on the left above. Now enter the title of the 

publication in the search field. 

2. Call up the detail page of the publication by double-clicking on it. Scroll down 

to the "Links" field. 

3. Enter your name (last name, first name) in the search field. Below that, two 

drop-down fields appear with “Name” and “Relationship”. 

4. Make sure that your name is in the first field and then select the “Editor of” 

option under “Relationship”. Click the “+” symbol to complete the process. 

In the case that you are looking for a specific publication from the former university 

bibliography, select “Reporting” → “Search” → “System Search” in the menu and 

enter the title of the publication you want. A search using the publication ID under “My 

Profile” → “Settings” → “Name based Search” is not intended for entries from the 

university bibliography. 

Is the publication data from external bibliographic databases automatically 

updated?  

Updates regularly take place to ensure that the information already integrated from 

external bibliographic databases is automatically updated. The exact time of update 

can vary depending on the database. If, after several weeks, you find that new entries 

have not been included or that an entry’s details deviate from the information in the 

source database, you are welcome to contact us. 
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How do I import publications from Index Theologicus or Index Religiosus in 

the correct format for Gutenberg Research Elements?  

 

Index Theologicus 

Using the search function, especially the author search, or analogously corresponding 

settings in your user account, you can call up a list of your publications on the Index 

website. You can now select individual publication entries or the list as a whole for 

export by setting the corresponding checkmarks on the left side of the overview. Then 

click on "Export" in the upper display area and select the following option under Media 

type in the pop-up window that opens: 

RIS (Citavi, Zotero, etc.). 

 

Then confirm by clicking "Export" in the window and you will receive a file in .ris format 

after the export process is complete, which you can save and use for subsequent 

import into Gutenberg Research Elements. Details on the import process can be 

found in the FAQ below for the question "How can publications be imported?". 

Index Religiosus 

Using the search function, especially the author search, or analogously corresponding 

settings in your user account, you can call up a list of your publications on the Index 

website. You can now select individual publication entries or the list as a whole for 

export by setting the corresponding checkmarks on the left side of the overview. Then 

click on "Export" in the upper right display area, which will redirect you to the 

corresponding export page. There, please select the following option among the 

available file formats for export: 

.ris -Research Information Systems Format. 

 

After that, confirm by clicking "Export" in the window and you will receive a file in .ris 

format after the export process is completed, which you can save and use for 

subsequent import into Gutenberg Research Elements. Details on the import process 

can be found in the FAQ below on the question "How to import publications?". 

How can publications be imported?  

In the drop-down menu on the left above under “My Profile” → "Tools" → "Import 

Publications" you can upload bibliographic data on a new publication in BibTeX 

format (*.bib) or RIS format (*.ris). These can be exported from an external database 

or the literature management programs Citavi or Endnote. After selecting and 
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uploading the import file, you can preview the file using "Records to import" and 

decide for each title how you like to continue with this entry. 

What is the "Publication status" and which options are available? 
The "Publication status" shows the current status of the publication. The following 

options are available: None, Accepted, In Preparation, Published, Published online, 

Submitted or Unpublished.  

It is not recommended to upload publications whose status is set as "In Preparation", 

"Submitted" or "Unpublished" in Gutenberg Research Elements. There are three 

reasons for this:  

1) The publication with the status is not marked as such in your Research Profiles 

public profile. So if researchers do a search for this publication, it would be 

unfindable.  

2) The manual entry of this journal article represents a large amount of work in 

terms of its maintenance. If it does not appear, the entry would have to be 

deleted, but if it does appear, the bibliographic data would have to be added.  

3) There is a high probability that a duplicate will be generated in your publication 

list by the automated transfer from scientific databases after the article has 

been published, so that you will have to manually join the articles (see FAQ: 

"How do I manually join duplicates in the workspace?"). 

What are preprints?  

Preprints are preliminary versions or manuscript versions of scientific publications, 

especially journal articles, that are made available to the (professional) public. These 

are versions that have not yet been assessed, the main purpose of which is to publish 

them to accelerate the exchange of research results. Preprints are published freely 

accessible on preprint servers - e.g. ArXiv. 

How can I import preprints from ArXiv?  

Preprints are preliminary versions or manuscript versions of scientific publications, 

especially journal articles, that are made available to the (professional) public. These 

are versions that have not yet been assessed, the main purpose of which is to publish 

them to accelerate the exchange of research results. Preprints are published freely 

accessible on preprint servers - e.g. ArXiv. 

How can I include preprints manually?  

You can find a description of the procedure under the "FAQ - How can I include 

publications manually?". 
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Please note that a preprint should always be recorded as a preprint type, regardless 

of its later appearance (book chapter, book, article, etc.) - otherwise there may appear 

duplications later. In addition, it is always necessary to specify the respective preprint 

server. If the preprint is not yet online, Gutenberg Open Science can be used for it. 

ORCID  

What is the ORCID iD? 
The ORCID iD is a unique digital identifier for researchers that allows you to avoid 

incorrect assignments of publications when the researchers' names are similar. You 

can create an ORCID iD by registering at https://orcid.org/. At ORCID you can also 

publish a personal researcher profile and deposit your publication list. 

What happens if I enter my ORCID iD in the settings?  

Once you have registered for it, ORCID can be used when searching in external 

bibliographic databases; see the question „Can I skip the Pending List and 

automatically claim publications from external bibliographic databases?". 

Additionally, the publication data collected in ‘Works’ will be used as a secondary 

data source. This means that entries you have acquired in ORCID with a digital object 

identifier (DOI) are automatically placed on your Claimed List. However, this is only 

true for entries whose DOI is found in one of the external bibliographic databases. If 

the search for a DOI entry entered in ORCID does not turn up any results in external 

bibliographic databases, the publication will not automatically be placed on the 

Claimed List. 

How can I send my publications from Gutenberg Research Elements to 

my ORCID Account?  

 

Select "ORCID Settings" from the drop-down menu on the left above under 

"Settings". On the following page, you can link your ORCiD to Gutenberg Research 

Elements using "Configure Connection" if you have not already done so.  

After linking the accounts, you can select various options under "I permit Symplectic 

Elements to" which affect the permissions regarding your ORCID account. 

1) "read data and write publication data to my ORCID account": With this 

choice you give Symplectic Elements the most rights to automatically claim 

your publications. Selecting this option will provide you with further 

configuration options under "Manage which publications can be sent".   

- With "For journal articles, send 'published' and 'published online' 

only" only published journal articles will be sent to ORCiD. This setting 

https://openscience.ub.uni-mainz.de/
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is recommended. However, this option only works if you have set your 

user profile in Gutenberg Research Elements to "public". This also 

means that you have activated a public profile in Research Profiles. All 

information about Research Profiles, the public profile of Gutenberg 

Research Elements, can be found in the category "Research 

Profiles". 

Note: You can view the publication status of your publications in Gutenberg Research 

Elements under "My work" and there under "My claimed publications". On the right 

side of the publication list, you will find an option to filter the list by publication status. 

If you know the publication status in the publication entry, but you cannot see it in the 

entry, you can create a manual entry on the object detail page by clicking on the blue 

button with the plus sign and add the publication status there. This manual entry will 

then be preferred by Gutenberg Research Elements. 

- With "Send all publications to ORCID including those with 

privacy levels of private or internal" all publications including those 

that are set to not visible in Gutenberg Research Elements via their 

privacy level will be sent to your ORCID account. If you have set your 

profile in Gutenberg Research Elements to "internal", please select 

this option. 

- With "Only send favourite publications" only publications marked 

as favourites in the publication list by the heart button will be sent to 

ORCID. You should also select this option if you have set your profile 

in Gutenberg Research Elements to "internal".  

Before sending the publications from Gutenberg Research Elements to ORCID, 

please check if your publication list in Gutenberg Research Elements contains 

duplicates. If this is the case, you can merge them (see: FAQ "How do I manually 

merge duplicates in the workspace?"). If duplicates do make it into the ORCID 

account, you can merge them under "Actions" and "Combine works" above your 

"Works" list. 

If you want to send the publications from Gutenberg Research Elements to ORCID, 

click on "Run Sync". Once the process is complete, the button is clickable again. 

However, you will also be shown the progress of the operation. When the process is 

complete, you will see how many publications were sent and how many were not due 

to private relations or pending publication. 
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The connection between your Gutenberg Research Elements profile and your ORCID 

account remains permanent. However, you can undo it by clicking "Remove from 

ORCID" next to the display of existing publications in the account, where they will be 

deleted. 

If you want to send information about your affiliation to your ORCID account, click on 

the button "Send affliation". You will then always be shown when you last sent this 

information. 

2) "read data from my ORCID account": if you select this option, Research 

Elements can use the information in your ORCID account to increase the 

accuracy of your search results in the pending list. 

3) "only use my ORCID iD to automatically claim": If you select this option, 

publications will be claimed based on your ORCID iD in Gutenberg Research 

Elements. 

Manual input and import of publication entries 

 

How can I include publications manually?  

You can manually include different types of publications in following the steps below: 

1. Use the drop-down menu on the left above and go to your publication list via 

"My Profile" → "My Work" → "Publications". 

2. Using the black "+" symbol ("Add a new publication") in the upper area of the 

window on the right-hand side to manually enter a new publication. 

3. There you can add different types of publications. Additionally, with help of the 

DOI, several fields are automatically filled in when adding journal articles. If 

this is not the case, you will be sent to a form to manually fill out the entry 

when clicking on ‘skip’. 

How can I record my specific contribution to a journal article? 

On the objects detail page of journal articles, you can enter who made which 

contribution after you have entered it. You can find this possibility on the object detail 

page in the category "Contribution". Click on "Add" in the "Contribution" box. You 

will land on a new page where you will see a free text field titled "Description". Here 

you can enter the exact contributions and save them. 
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What can I do if the titles of some of my publications are not displayed 

correctly in Gutenberg Research Elements?  
In some publication entries, some special characters are not displayed correctly and 

XML tags are appearing in the title. This sometimes happens when metadata is taken 

from external bibliographic data sources. This affects the display of the publication 

record in Gutenberg Research Elements, as well as the display in Research Profiles 

and the Unibibliography. By creating a manual publication entry with the correct title, 

you can fix this incorrect display. Follow the steps below to do this: 

1. Go to the publication's details page, for this you need to click on the title (you 

will find the publication under "My Publications"). 

2. At the bottom right of the data sources section, click on the button with a big 

"+". This button is used to create a manual entry of the publication.  

3. You can now edit the bibliographic information of the entry.  

4. Change the title of the publication so that the incorrect XML code disappears. 

If you don't remember the complete correct title, you can either find it in 

another data source (listed in the data source area) or you can search for the 

publication at the respective publisher (click on the ID link in the respective 

data source). 

How do I record a lexicon entry in Gutenberg Research Elements? 

To record a lexicon entry in Gutenberg Research Elements, select the publication 

type "Other". In the following window, use the "Sub-types" list box "Lexicon entry" to 

add your entry. 

How do I record a "corresponding author", "first author" and "last author" for 

a journal article? 

When entering journal articles in Gutenberg Research Elements, you can specify 

different types of authors. This allows you to record which author is the "corresponding 

author", which is the "first author", and which is the "last author" of the publication. 

When specifying the author field, there is another selection field below the name field 

in which one of the three author types can be specified. It is also possible to specify 

several author types, since an author can also be corresponding and first or last 

author of a journal article. Furthermore, it makes sense to add several author types to 

an author and not to create several author fields with different author types. 

What does the button unverified mean for manually entered publications?  

If you have entered a publication manually, the "unverified" logo appears at "Data 

sources" in the top right corner. This means that the information entered for the 
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publication is transferred to the system and displayed there exactly as you have 

specified it. 

The "unverified" button appears because the system theoretically enables 

subsequent processing. In contrast to the former university bibliography, no 

subsequent processing or supplementation of the publication data by library staff is 

intended. It is therefore important that you enter the publication data as precisely as 

possible. 

How do I create a .bib file in Citavi for upload to Gutenberg Research 

Elements?  

In Citavi, select the project you want to upload to Gutenberg Research Elements as 

an export in .bib format. To create an export file in the desired format, please perform 

the following steps: 

1. In the bibliographic records management, select the command "Export → 

Export..." from the "File" menu. 

2. Select all titles in this project that you want to export and then click on "Next". 

Select "BibTeX" as target format. Click on "Next". 

3. Click "Browse" to select the storage location for the BibTeX file you want to 

export. 

4. If necessary, select from the other options for the BibTeX export. 

5. Click on "Finish". Citavi will create a BibTeX file in .bib format in the desired 

location. You can then upload the created file to Gutenberg Research 

Elements as described on this FAQ page. 

6. In order to see the individual fields in .bib format, you can open the .bib file via 

editor if you want to have a look at the fields. Therefore, right-click on the file 

→ "Open with..." and choose the editor program. Afterwards, save the file to 

your preferred storage location. 

 

As an editor, how can I claim entries from Google Books? 

The drop-down menu on the left above takes you to your publication overview via "My 

Profile" → "My Work" → "Publications". There you can add a new publication via 

the black "+" symbol ("Add a new publication") in the upper area of the window on the 

right. In the interaction field that now appears, select "Select publication type" → 

"Book". You can then search for your entry from Google Books using the title or ISBN 
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and add further information. To subsequently mark your status as editor of the work 

in Gutenberg Research Elements, you have to adjust the informations under "Links" 

and the metadatas under "Data Sources".  

To do this, please follow the steps below: 

1. Access the detail page of the record after you have added it to your 

publication list. To do this, select the required title of the entry by double-

clicking on it to call up the detailed view. 

2. Select "Add manual record" by "Data Sources" and enter your name under 

"Editors" on the following page to add it to the list. If necessary, you can also 

delete your name from the list of authors in this section.When you have 

finished entering your name, scroll down and click the "Save" button to save 

the process. You will see the changes on the previous page by "Data sources". 

To indicate the status of the publisher in the "Links" section, proceed as follows: 

1. Scroll to the "Links" section → "User" and click the "Edit" button. 

2. On the following page, select next to "Link Type" the function "Edited by" 

from the drop-down-list, and then click "Update". 

3. You will be returned to the detail page of the record, where the status should 

now be set as "Edited by" in the "Links" section.  

What do I do if my username in the system and the name I publish under do 

not match?  

You can add name variations in your account in the following steps. Go to the drop-

down menu on the left above under "My Profile" → "Settings" and select "Name 

based Search". By the "Name based search terms" you can add different name 

variations. This allows you to assign publications to your account even if your 

username doesn't match the published name in the publication. 

Please note that the automatic assignment of publications may take some time after 

adding name variants. 

How can I manually join duplicates in the workspace?  

1. Call up your publications in the drop-down menu on the left above under "My 

Profile" → "My Work" → "Publications". 

2. To add the desired publications to the workspace, click on the three-dot menu 

("More") above the publication data on the right and select "Add to 

Workspace".  
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3. Once you have added the desired publications to the workspace, open it by 

selecting "My Profile" → "Tools" → "Workspace" from the drop-down menu. 

In the new input screen, you can now select the desired publications.  

4. To join the duplicates, click on "Join" in the upper interaction field. 

 

Note: After merging the duplicates, it may happen that one of the two entries remains in the 

workspace and has to be removed manually. To do this, first select the publications that are 

to leave the workspace. Finally, select "Clear the workspace" in the top bar to remove 

them. 

 

What do I have to consider when joining duplicates manually? 

You should only merge join if they are actually duplicates. You can determine this by 

the title and other similar metadata. When merging duplicate records, please make 

sure to select the correct target record.  

This can be identified by correct database information and repository URL.  

Add the target record to the workspace first. This should also be followed when setting 

the checkmark, first select the target dataset, then select the non-target dataset. After 

merging, clean up the workspace to avoid errors during the next merge. 

Before merging, document important metadata for both datasets (Elements dataset 

identifier, the repository URL or presence of an uploaded file, co-author relationships, 

preferred data source, visibility status, and favorite status). 

How can (co-) editorships in research paper series and magazines be 

recorded? 

(Co-) editorships for research paper series and magazines can be created at 

"Professional activities" under the heading "Editorship". The categories here follow 

the European standard for research information systems. 

Please note that information on professional activities cannot currently be transferred 

to WordPress lists. 

How are my publications assigned to existing organizational units in 

Gutenberg Research Elements? 

The publications of the scientists are initially automatically assigned to the respective 

organizational units in Gutenberg Research Elements according to the existing 

organizational structures from the IdM (identity management). The assignments can 

be changed by you. 

This information on the organizational units of the IdM is not linked to persons in 

Gutenberg Research Elements, but to publications. They are used to enable the 
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display of publication lists for organizational units on the homepages hosted by the 

ZDV. 

In order for your publication to appear on your organizational unit's publication list, the 

following requirements must be met: 

1. The publication must be assigned to your organizational unit in Gutenberg 

Research Elements. 

2. The publication must be claimed by you. 

Links from the IdM are automatically added on a regular basis for new publications. 

How can I change the assignment of organizational units to my publications?  

If corrections regarding organizational units are desired, you can delete the links and 

create new ones. These will remain stable even after updates from the IdM. 

Organizational units can be removed as well as added. 

To add new organizational units, proceed as follows:  

1. Click on the corresponding publication. In the detail view, you will find the 

"Relationships" box on the right-hand side. Now click on "Create new" and 

select "Organisational Structure". 

2. On the following page, select "Anyone" in the panel on the right under 

"Organisational structures" → "Linked to" in order to get results. 

Additonally, you can enter the name of the organisational unit you are looking 

for under "Name".  

3. To delete organisational units, proceed as follows:  

• Click on the corresponding publication. In the detailed view under "Links" you 

will find the already linked organisational units.   

• If you want to remove an organisational unit, click on the red "x" symbol and 

confirm this with "OK". 
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Detail Page 

 

How do I access the detail pages of my publications/grants/professional 

activities? 

Each object in Gutenberg Research Elements has an object detail page that can be 

opened with one click and contains important information about the respective 

publication, grant or professional activity.  

The detail pages can be accessed via the respective object lists in (Publications, 

Grants and Professional activities) ("View all") or can be found via search.  

How is a detail page structured? 

The object detail page in Gutenberg Research Elements is structured as follows:  

Top Panel 

In the upper part of the page there is an icon for the respective object type, the title 

and, in the case of a publication, the author of the object. Clicking on the "See Details" 

link next to the author name opens an author details window on the object details 

page, which you can browse.  

Here, researchers can review information about authors associated with a work, 

including their names, affiliations, and researcher identifiers such as ORCID ID. 

Clicking on the author's name opens a new window with a search function that allows 

users to quickly find the author they are looking for with their full name.  

In addition, the type of the object can be changed, another symbol for the object type 

can be added, and details about the author can be viewed: e.g. his full name, which 

is only displayed in this view. In the icon field of the object type it is possible for the 

researcher to upload a thumbnail. Furthermore, you can manage the labels to the 

object, the privacy settings, mark the object as a favorite or add it to the workspace.  

Right Column 

On the right side of the page you can see the report date and the relations of the 

object, for example to its author. New relations can also be created.  

Furthermore, the history of the page is listed on the right margin and can be expanded 

or it is expanded automatically when the page is edited. Below the object title, in the 

case of a journal article, there is a citation here and furthermore the object can be 

accessed, viewed and retrieved via the DOI on the publisher's page if the researcher 

has the rights to do so. In the case of a conference, the title of the object and the 

venue and date of the event can be seen.  
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How can I edit bibliographic data for my publication? 

The panel titled "Data Sources" contains the bibliographic data for the object such as 

the title, an ID, the author(s), and other information such as the conference location 

or journal issue. Here you can edit manual entries, lock editing or mark the entry as a 

favorite. The data sources view and the relations section view are configurable and 

you can select a preferred view. When viewing the data sources, you can choose 

whether to display them reduced or full.  

What is the purpose of the relations section? 

The Relations section shows you a summary of all existing relations and you can click 

to view the full details of each group of relations and open a new window where you 

can claim or reject relations and edit relation details. New relations can also be 

created here. When viewing relations, you can choose between a map view or a list 

view.  

How can I separate information about my publication from the details page?  

Records that come from external sources can be split from the details page and thus 

separated from their objects, making it easier to remove records that may have been 

merged in error. However, to minimize the risk of incorrectly splitting records here, 

there is still a confirmation message. The record view can be opened or closed, which 

means that less information is visible. It is possible to add manual records of the object 

in addition to the existing records.  

What is the Repository panel used for? 

The Repository panel shows whether the object is in a repository and the object can 

also be added to the repository via a button. 

What is the OpenURL resolver and what is it for? 

Another feature is that a display name can be configured for the OpenURL resolver 

so that users can view a publication about their organization's library collections using 

an OpenURL resolver (e.g. SFX). Organizations can now specify a display name for 

their link resolver to align with local terminology, rather than uploading an icon. In this 

way, the system can support researchers to easily access copies of their work and 

improve accessibility.  

How can I edit publication data from the details page? 

The details page includes many features to allow researchers in Gutenberg Research 

Elements to manage their datasets quickly and easily. First, researchers can manage 

privacy settings from the object detail page. It is thus possible for them to view and 

control the privacy levels of their objects via the object details page. Secondly, from 

an object detail page in Gutenberg Research Elements, it is possible to claim or 
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decline a publication if this has not already been done. This option is at the top of the 

page if the publication is in the Pending list. It is also possible to make a copy of 

Professional activities from the detail page. The function is available on the object 

detail page from the "More actions" menu at the top right of the page. 

What are labels in Gutenberg Research Elements? 

In Gutenberg Research Elements, it is possible to assign labels to objects such as 

publications, grants, or professional activities to identify them and indicate that they 

belong to certain subject classification or scientific fields. Labels can be used in 

Gutenberg Research Elements to create lists for the WordPress plugin. Labels can 

be assigned via the object details page. Likewise, labels can be assigned in a user 

profile in Gutenberg Research Elements to indicate which research areas the 

researcher is active in. If these labels are assigned, they also appear in the public 

profile in Research Profiles and can be used there as keywords or tags for searches.  

How do I assign a label? 

The process of assigning labels when adding new publications is as follows: 

1. Go to the "Add New" link on the home page under the "Publications" 

category. 

2. The window for entering the title will open. 

3. After entering the title, you will be asked to enter the other publication data. 

4. Under the field Keywords you can enter a term into the field for the desired 

subject classification. If the term is similar to a label of the subject classification 

(e.g. Subject Areas (2020 -2024)) it will already be suggested. Keywords that 

are not part of a subject classification can also be assigned; these will then be 

grouped under the label "Unclassified" and should be entered there. 

5. When saving the publication data, the labels are also saved.  

6. The assigned labels are now visible to all researchers in Gutenberg Research 

Elements as well as in the university bibliography. 

However, labels can also be assigned subsequently. This is possible as follows: 

1. Go to the object detail page of your publication via your publication list "My 

Publications". 

2. In the lower part of the object detail page you will find the section "Labels", 

where all assigned labels are listed 

3. You can go to the individual labels under "Edit" or click on the "Manage 

Labels" icon. Some labels cannot be edited, these can only be viewed by 

clicking on them ("View").  
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4. In both ways you will get to the edit mode. In it you can see the assigned 

labels of each subject system (and those without subject system). You can 

switch between the individual label categories by clicking on them and get a 

description of the subject classification and the label in each category.  

5. You can add new labels in an input field. However, with the exception of the 

"Unclassified" category, labels are only added if they correspond to a term in 

the subject classification. If the search for a term is successful, the term is 

suggested and can be added. For "Unclassified" labels, any term can be 

added. 

6. Labels that you have added yourself can also be removed: to do this, click on 

the small "x" at the top right edge of the field surrounding the term in each 

category for the assigned labels below. However, editing is possible only for 

labels assigned by you, automatically assigned labels coming from the data 

sources cannot be edited. 

7. You still need to save the changes, which can be done by clicking the "Save 

changes" button below. 

8. The assigned labels are now visible in Gutenberg Research Elements as well 

as in the university bibliography for all researchers. 

 

Which labels are visible on an object detail page in Gutenberg Research 

Elements and can be assigned? 

Various labels can be seen on the object detail page. These labels can come from 

Gutenberg Research Elements as well as from external data sources, which means 

that these labels have already been assigned within the external data sources. The 

different labels that can be seen on an object detail page:  

o Availability: Describes the types of opportunities you would like to be 

contacted about, such as industry projects, mentoring, or media 

inquiries. Once collected, this information can be reused (depending 

on configuration) in a number of ways, including in your public profile. 

This label comes from an external data source and cannot be assigned 

within Gutenberg Research Elements. (see docs for details) 

o DNB Subject Groups: Label indicating the subject group of the 

German National Library. 

o Fields of Research (2008): Controlled structured research 

categorization scheme created, maintained, and provided by the 

Australian Bureau of Statistics. Categories include major fields and 
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related subfields of research and emerging areas of study. This is the 

2008 version of the scheme, which has been replaced by the 2020 

version. This label can also be assigned in a researcher's profile for 

the researcher.  

o Medical Subject Headings (MeSH): Controlled and organized 

vocabulary created by the National Library of Medicine (USA). MeSH 

contains the subject headings that appear in MEDLINE/PubMed, the 

NLM Catalog, and other NLM databases. This schema corresponds to 

the updated vocabulary for 2021.  

o Research, Condition and Disease Categorization: Computerized 

process used by the NIH (National Institutes of Health) to categorize 

and report the amount it funds in each of 233 reported categories of 

diseases, conditions, or research areas. This label comes from an 

external data source and cannot be assigned within Gutenberg 

Research Elements. 

o Science-Metrix: Controlled structured research categorization 

scheme created, maintained, and provided by Science-Metrix. 

Keywords are automatically derived from ISSNs using the Science-

Metrix Journal Classification list.  

o Subject Areas (2020-2024): These subject areas allow scientists to 

indicate their research fields according to the DFG Classification of 

Scientific Disciplines, Research Fields, Review Boards and Subject 

Areas (2020-2024). This label can also be assigned in a researcher's 

profile for the researcher.  

o UK Health Research Classification System (HRCS): Customized 

system for classifying the full spectrum of biomedical and health 

research. Health categories are used to classify the type of health or 

disease being studied. This label comes from an external data source 

and cannot be assigned within Gutenberg Research Elements. 

o UK Health Research Classification System Research Activity 

Code: Customized system for classifying the full range of biomedical 

and health research. Research activity codes classify the type of 

research activity being conducted. This label comes from an external 

data source and cannot be assigned within Gutenberg Research 

Elements. 
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o UN Sustainable Development Goals: Sustainable Development 

Goals (SDGs) are at the heart of the United Nations 2030 Agenda for 

Sustainable Development, adopted by all UN member states in 

September 2015 as a new action plan. This label system allows 

authorized users to indicate how researchers and their work contribute 

to the achievement of specific goals. This label comes from an external 

data source and cannot be assigned within Gutenberg Research 

Elements. 

o Unclassified: Labels with no associated label scheme. These can be 

assigned independently. 

How does the Altmetrics display work on the details page of a 

publication in Gutenberg Research Elements? 
In the bottom part of the object detail page of a publication in Gutenberg Research 

Elements, various metrics can be displayed, e.g. from Altmetrics, Web of Science, 

PubMed and Dimensions. All of these are listed in a panel titled "Metrics". Not all 

publications have this section available. The metrics are displayed if a DOI is available 

in the publication entry. The DOI (Digital Object Identifier) is used to view the 

Altmetrics Attention Score. The Altmetrics Attention Score is an indicator of the 

amount of attention the publication has received. This attention is a calculated count 

of mentions a publication has received in specific media outlets and channels on the 

Internet. The Altmetrics Attention Score is represented via a badge that shows the 

metric. Clicking on the badge opens the Altmetrics page of the publication entry. It 

also mentions how many times an entry has been read on the reference manager 

software Mendeley. 

This score is generated by an automated algorithm and presented as a weighted 

number. The ratings vary depending on the type of medium or channel in which the 

publication was mentioned, e.g. a mention in a newspaper article is weighted higher 

than a mention in a post on social media. The Web of Science science score and the 

Europe Pub Med score are also calculated by the two portals according to how often 

the article was cited. 

On the detail page in Gutenberg Research Elements the displayed Altmetrics score 

has to be a whole number, which means that non-whole number mentions are 

sometimes rounded up to one.  

If Altmetrics cannot find any numbers, the badge is gray and shows a question mark. 

If mentions are found by Altmetrics, the weighted number is displayed and prorated 
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to match the colors of the sources in its weighting table. Altmetrics searches for 

relevant mentions in social media sites, journal policy documents, blogs, Wikipedia, 

and many other sources. If mentions are missing, you can report them to Altmetrics. 

In addition, one can be notified when the publication is shared for the first time. 

Similarly, the dimension score is displayed via a badge. This shows how often the 

article has been cited. Clicking on the Dimensions badge on the publication's details 

page takes you to a Dimensions details page. The detail page contains information 

on four citation-related metrics, as well as additional information on citing publications 

and citing research categories. From the Dimensions Badge detail page, the user can 

view additional details. In addition, charts of citations over time and a list of all citations 

are available here. The research areas in which the article is cited are also displayed 

in a visualization. 

Professional activities 

What are Professional activities? 

With the module “professional activities” scientists can specify various aspects of 

their professional profile. These academic activities, such as working on a 

committee, a research project or editing a publication, can be linked to other data 

elements in this way and made visible on your user profile. 

 

Which Professional activities can be recorded? 

You can add a Professional activitiy by selecting “My Profile” → “My Work” → 

“Professional activities” in the drop-down menu on the left above. Then click on 

the large plus in the upper right corner of the screen to add a Professional activity. 

The options that can be selected are listed below: 

Distinction, Broadcast Interview, Committee membership, Community service, 

Conference reviewing / refereeing, Conference hosting, Consulting / Advisory, 

Editorship, Editorial board Editorial, Employee supervision, Event administration, 

Event participation, Expert witness, Fellowship, Grant application assessment, 

Institutional review, Journal reviewing / refereeing, Membership, Non-research 

presentation, Office held, Promotion / Tenure assessment, Text interview. 

If you click on the desired academic activity, you will be given the opportunity in the 

new window to manually enter the necessary data for your option in the text fields. 
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Search tools 

How can I search Gutenberg Research Elements by content (e.g. publications, 

grants and professional activities, etc.)? 

Via “Reporting” → “Search” → “System Search” you can search Gutenberg 

Research Elements for specific content, save searches and search current 

publications within your institution. 

Enter keywords, phrases or a wildcard (*) to search elements, e.g: 

• Keyword: Nuclear physics 

• Phrase: The deconstruction of the person of Charlemagne 

• Placeholder: Stem cell* research 

In the advanced mode of the "System Search" you can further restrict the search by 

specifying data and selecting which items to search for, e.g: 

• Publications 

• Projects 

• Professional activities 

You can then choose which results you want to see: 

• Entries (as shown in the examples above), or 

• Users in relation to the entries 

Finally, you can also limit the search results in Gutenberg Research Elements to 

certain users or groups. 

How do I search for an entry in Gutenberg Research Elements? 

To search for an entry, please use the drop-down menu on the left above under 

"Reporting" → "Search" → "System Search". For example, if you know the title or 

file number of a third-party project, you can enter this information directly in the search 

window. For a broader search, select the 'Advanced' setting. Here you can narrow 

down your search step by step and, for example, display entries for different research 

information. Don't forget to check 'Johannes Gutenberg University Mainz' before you 

start your search. 

What options do I have to find other users in the system?  

In Gutenberg Research Elements you have basically two possibilities to find other 

users in the system. 
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You can specifically search for other users in the drop-down menu on the left above 

under "Reporting" → "Search" → "System Search". Another possibility is to call up 

your profile in the left column with the "Profile" button. There you will find a search 

field on the right side under "Find a colleague". Enter the last name of the person 

you are looking for in the input field below to receive corresponding suggestions. 

Thus, you can quickly and easily find users in the system. 

Can I search for titles that contain special characters?  

If you search for specific entries (e.g. publications or research projects) in Gutenberg 

Research Elements, please note the following for the title search in the "System 

Search": 

Certain title elements like 

• Special characters (e.g.: -, _, /, :, ;, ?, !) 

• Numbers in title 

• Language-typical special characters (e.g.: ^, ', `) 

can sometimes cause the desired entry not to be output as a result of the search. If 

you encounter this problem during your search, try to use only a section of the title, 

ideally with as few or none of the problematic title elements as possible in the search 

query. If you still cannot achieve the desired result, please contact the support team 

and describe your problem there. 

 

Grant Assignment 

 

How do I add a grant to my profile and create links between publications and 

grants?  

Grants relate to individual interfaces in MACH. To assign third-party funded projects 

from MACH, follow the steps below:  

1. First call up your own profile using the “Profile” button in the left column and 

then click on “View all links” on the right side under “Links”. 

2. If you now click the drop-down menu “Create left” in the upper right area of 

the new window and select “Grant”, another input mask appears. Under 

“Choose link type” you will be asked to select the appropriate “Link type”. In 

the input field under “Search text” you can search for the third-party funded 

project by title or file number. 
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3. In the next step, select the project you want and confirm your selection with 

“save” so that it can be displayed in your profile under “Grants”. 

You can create links between your publications and third-party funded projects (as 

well as all other objects) in the drop-down menu on the left above under “My Profile” 

→ “Tools” → “Create Links”. To do this, proceed as follows: 

1. In the new window, first select the object types to be linked under “Create 

links between…” →“Publications” and “... and…” → “Grants”. 

2. You can then search for the desired publication using the DOI or title by 

clicking on “GO” as soon as you have entered the information. 

3. You can search for the desired third-party funded project by title or file number. 

Once you have selected the required objects, confirm the link with “Create 

new link (s)”. 

Which project data is captured in MACH?  

Information on grants will be imported to Gutenberg Research Elements from our 

financial management system MACH. Please take into account that up until now 

MACH was only used for internal administrative purposes regarding the allocation of 

funds and postings. 

For more information concerning the creation of an account for third party funded 

projects at JGU, click here. 

How can projects that are not financed by third party funds be added in 

Gutenberg Research Elements?  

Non-third-party funded Projects, which are not listed in the output of MACH, will be 

added from Planning and Controlling into Gutenberg Research Elements. 

If you wish to add such a project, please send an email with the subject line “New 

project”. You will receive an email listing required information regarding your 

project which you need to provide. 

After the successful termination of the CRIS-project phase, this process workflow 

should work more automated with an online questionnaire. 

How do I link publications to coordinated programs of the DFG or the profile 

and potential areas of the Rhineland-Palatinate Research Initiative?  

In addition to the “grants”, which refer directly to individual third-party funding cost 

centers in MACH, Gutenberg Research Elements in the “Projects” module also 

contains the coordinated programs of the DFG in more complex cost structures as 

well as the profile and potential areas of the Rhineland-Palatinate Research Initiative. 

https://www.verwaltung.finanzen.uni-mainz.de/drittmittel/einrichtung-eines-drittmittelkontos/
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How to assign a publication to a project:  

1. First, make sure that the desired project has been created in Gutenberg 

Research Elements. For this, select "Reporting" → "Search" → "System 

Search" in the drop-down menu on the left above. Now click on "Advanced" 

below the search bar. Search for the project by checking "Projects" under 

"System Search" → "Search criteria". Please note that currently only 

projects of the DFG and the Research Initiative Rhineland-Palatinate are 

displayed. 

2. In the second step, assign your publication to the project. Use the drop-down 

menu "My Profile" → "My Work" → "Publications" to access your publication 

list. 

3. Select the requested publication by double-clicking on it to open the detailed 

view. Under "Relationships" click on "Create new" → "Project". 

4. In the following window, select "Create links between Publications and 

Projects". Additionally, select "Linked to” → “Anyone" under "Projects". Now 

click on "Go." A list of all projects will be displayed. If required, you can narrow 

down the search under "Name". 

5. To complete the process, select the requested project and click "Create a new 

link". 

 

Full text upload to the Gutenberg Open Science repository 
 

What is Gutenberg Open Science?   

Gutenberg Open Science is the open access repository of JGU. Its purpose is to store 

the full texts of publications (and research data) and their metadata from all subject 

areas and from all university members with various but principally open reuse rights 

(licenses) and to be part of a standards-based, international publication infrastructure. 

 

What does the deposit button on the detail page of my publication mean?  

If you click on the deposit button for your publications, the full-text status of the 

respective publication will be displayed in an info box, i.e. information on whether a 

full-text is currently already deposited in our repository OPENSCIENCE.UB or in the 
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former university bibliography METADATA.UB.  

It is also possible to upload journal articles directly from Gutenberg Research 

Elements to the Gutenberg Open Science repository. You can find out how to upload 

a publication to the repository via Gutenberg Research Elements under "How do I 

upload a journal article to the repository using the deposit function of 

Gutenberg Research Elements?" 

 

What is the purpose of the Gutenberg Open Science repository? 

The Gutenberg Open Science repository is a service for digital publishing at JGU.  It 

supports Open Access as an essential component of open science culture (see JGU's 

Open Access Policy). It strengthens the visibility of research results and enables quick 

access to the content of publications. In addition, it supports the Open Access 

obligation by third-party funding bodies such as the EU or DFG and stores the 

publications funded at JGU in the long term. 

 

Which publications can be uploaded to Gutenberg Open Science with the 

deposit? 

With the Deposit on Gutenberg Open Science, only journal articles  

(published or accepted version) can be uploaded. The requirement is that the 

publisher allows a secondary publication. A publication with a CC license can be 

uploaded without any problems. 

 

How do I upload a journal article to the repository using the deposit function 

of Gutenberg Research Elements? 

1. Open the object detail page for your publication.  A publication's detail page 

can be accessed from your publication list by following „My Profile“ → „My 

Work“ → „Publications“. 

2. Click on "OPENSCIENCE.UB" in the "Repository" box on the object details 

page. 

3.  Click on the "Deposit" button to start the deposit. You will also find this in your 

publication list in each publication entry without going to the details page. 

4. If your publication has not been published with a CC license, you must check 

whether you are allowed to upload it. Click on "SHERPA RoMEO advice". You 

can also leave a comment here. 
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5. Under "File version", select the "published version" (publisher's PDF) or the 

"accepted version" (latest version of the accepted manuscript) and confirm this 

with "Use this file". 

6. Enter the license ("Reuse license") and a message to the library in which you 

can provide additional information or ask questions about this licence   

("Comment" ). If the publication has not been published under a CC license, 

please select "InCopyright". 

7. Click on "Deposit" to send the publication to the repository. 

 

You can also find a quick guide to uploading the full text on the homepage of Mainz 

University Library under Gutenberg Research Elements under "Downloads (PDF)".  

 

What is Sherpa Romeo?  

Sherpa Romeo is an online service that summarizes the Open Access policies of 

publishers and journals from all over the world. It provides an overview of publishers' 

conditions for the secondary publication of journal articles and provides reliable 

information on whether, when, where and with which version it is possible to publish 

a secondary publication. 

How can I check the deposit status in Gutenberg Research Elements? 

After you have submitted the publication, click on "View your publication" to return to 

the object details page of the publication.  You can view the status of the deposit 

under "Repository" →  "OPENSCIENCE.UB". Before the library has checked your 

deposit, the status is set to "not live". As soon as the journal article has been checked 

by the library team and has been activated in the repository, the status is set to "live". 

After the next update of your publication list on your public profile page, a link to the 

PDF file will appear next to the publication. For further questions, please visit the 

Gutenberg OpenScience help page at the following address: 

https://openscience.ub.uni-mainz.de/help-faq.  

 

 

 

 

https://openscience.ub.uni-mainz.de/help-faq
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Data Export, Integrating Publication Lists on Websites and the University 

Bibliography 

 

Data Export 

How and in what format can I export publication lists from Gutenberg 

Research Elements?  

 

It is also possible for users of Gutenberg Research Elements to export their own 

publication list as a BibTex, RIS, PDF, Word or Excel file. Follow the steps below to 

do this: 

From the drop-down menu on the left above, select “My Profile” → “My Work” → 

“Publications”. Here, there is the following to note: 

You can set how many entries are displayed on page. Here 10, 25, 50 or 100 entries 

are possible. You can also select the publications and check a box next to the entry 

to export this publication. Then, above your publication list, click on the button 

localized on the left with the inscription "Export". 

You can also select all publications by checking a box next to the "Export" button. 

However, only the publications that are displayed on the page will be selected here, 

depending on the number you have selected. If you want to export your complete 

publication list, however, do not set any check marks next to the entries and press 

"Export". 

Integrating Publications on Websites 

What content can currently be displayed on JGU websites?  

At the moment, all publications from Gutenberg Research Elements can be displayed 

on the JGU website. 

Unfortunately, projects, grants, equipment and professional activities cannot be 

displayed at the moment. We apologize at this point and will inform you as soon as 

the functionality is available. 

How are publication lists from Gutenberg Research Elements automatically 

displayed on homepages hosted by the ZDV?  

With the help of the new WordPress plugin for the websites at the university, you can 

have your publication list created and maintained on Gutenberg Research Elements 

automatically displayed on your homepage. By activating the plugin, you combine the 

advantage of low entry and maintenance effort for publication data in Gutenberg 

Research Elements with the advantage of a standardized, public display of your 
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publication list. Multiple entry of publication data in different systems becomes 

unnecessary. 

In addition to personal publication lists, lists can also be generated for entire 

organizational units and for freely selectable indicators (tags). Furthermore, different 

sorting options for the lists can be selected. 

A more detailed explanation can be found on the following page. 

If you have any further questions, please contact our support team 

at researchelements@uni-mainz.de. 

How can I set preferred record for publications for my WordPress lists? 

For each publication there can be several records in the listing under “(Data) 

Sources”, which come from different data sources. In addition, there may be a 

manual record that you created by post-processing a record taken from an external 

data source. 

You can set each of these records as a preferred record - to do this, mark the 

respective publication by clicking on the adjacent button "Set as preferred record". 

This preferred record will then be displayed in your publication list in Gutenberg 

Research Elements and transferred to your WordPress list. 

 

University Bibliography 

What is the University Bibliography? 

The University Bibliography is a publicly accessible search system for the publications 

of scientists and scholars at the Johannes Gutenberg University Mainz. In contrast to 

subject-specific databases, it records the volume of publications at JGU from an 

institutional perspective. 

Where does the data come from?  

Bibliographic records contained in the database are imported from the research 

information system (CRIS) Gutenberg Research Elements. Gutenberg Research 

Elements also incorporates all data from the former University Bibliography and from 

Gutenberg Open Science, JGU's open access repository.  

Due to this interlinking, the amount and completeness of the listed data in the 

university bibliography relies on the use of Gutenberg Research Elements. Authors 

who would like to see their publications represented in the university bibliography can 

do so by entering their data in Gutenberg Research Elements. Please note that only 

publications that are included in Research Elements can be found in the university 

bibliography. 

https://www.blogs.uni-mainz.de/eng/plugin/jgu-fis/
mailto:researchelements@uni-mainz.de
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What can I do if my publication does not appear in the University 

Bibliography?  

Your publication will not appear in the University Bibliography until you have claimed 

it in Gutenberg Research Elements. You can check this in the following steps:  

1. Please log in at https://researchelements.uni-mainz.de/ 

2. Select "Publications" in the menu area "My Profile" → "My Work". 

You can now view the publications that have not yet been claimed 

under "Pending".  

3. In the right area you can search for the desired publication by title or 

other filter options.  

When you have found your publication, click on "Claim". Now you have accepted the 

publication for your publication list and it will also be visible in the university 

bibliography the following day.  

How do I use the search slot and facets? 

You can start a free text search in the search slot at the top of the website. The 

system is searching in all fields of a data record. 

On the left-hand side you also have the option of restricting this free-text search 

using facets. The number of publications in each facet is displayed in ( ). 

In the "Category" facet, you can first preselect in which of the objects listed in the 

university bibliography the search should take place. You can choose between 

publications and organizational units. The facets listed below are then adapted to 

this preselection and can be used to limit the search result. 

Multiple facets can also be combined step by step by selection. If you have selected 

one or more desired search restrictions, the result will be displayed on the right side 

of the window. You can now continue searching in this set of results by entering 

search terms in the input bar. You can also remove individual restrictions, choose 

additional facets or start over. Under "Search history" in the upper right area you 

can view past searches in this session as well as delete your search history. 

How do I search in the category Publication?  

By pre-selecting the category "Publication" you can use the search bar to search 

through all the publication entries in the university bibliography. To further restrict 

the search result, you have the following facets available: 

• Publication type: Here you can choose between different publication types such 

as "Book" or "Journal article". 

https://researchelements.uni-mainz.de/
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• Author: Here you can restrict your search result using a list of all author names 

contained in the bibliographic data. 

• Year of publication: Here you can use the slide switch to set the year of 

publication or the period of publication you are looking for. 

• Organizational unit: Here the search result is limited to the publications of the 

organizational units listed. 

Publications from subordinate organizational units are included in the search results 

for the higher-level organizational units. For example, the list of FB 08 Physics, 

Mathematics, Computer Science contains all publications of the Institute for Nuclear 

Physics. 

• Data source: Here the search results can be restricted to individual data sources 

from Gutenberg Research Elements. 

How do I search in the category Organizational unit? 

With the preselection "Organizational Unit" in the "Category" facet, you search 

through all publication lists for organizational units in the search slot. To restrict the 

search result, you can further restrict the overall list of organizational units matching 

the search term with a selection list in the "Organizational unit" facet. 

On the overview page of the respective organizational unit, the publication lists of 

the subordinate organizational units are linked under "Includes" and the publication 

lists of the higher-level organizational units are linked under "is part of". 

Whom can I contact with questions? 

If you have any questions about registration, publication search, or how publications 

are displayed, please contact the Gutenberg Research Elements support team 

(researchelements@uni-mainz.de). Further information about the project can be 

found on the Gutenberg Research Elements homepage. 

 

Research-Profiles 

 

General 

What is Research Profiles? 

Research Profiles is a publicly accessible view for profile pages of Gutenberg 

Research Elements. This allows you to present your research profile with 

publications, grants, professional activities and projects to a larger network of 

https://www.ub.uni-mainz.de/de/gutenberg-research-elements


49 
 

scientists outside the university and to make this information more easily accessible. 

Interested parties can also contact you via your profile.  

How do I find researchers in Research Profiles?  

JGU researchers in Gutenberg Research Elements who have set their profile to 

"public" can be found via a search function. This setting is possible in Gutenberg 

Research Elements and has been set by the users there. The search field is located 

in the middle of the start page or after a successful search above the hit list to start a 

new search. Here you have the possibility to search for subject areas or for names. 

Within the search, a free text search or a search by tags are available, which can be 

set via a field next to the search field. The time period specified for Subject Areas 

does not refer to publications that have been or will be published in that time period, 

but to the time period in which the research programs are running.  

Who has access to Research Profiles? 

The Discovery Service is a public view of information from Gutenberg Research 

Elements.  

How do I access Research Profiles? 

There are several ways to access Research Profiles. One way is to open Research 

Profiles through Gutenberg Research Elements, which is useful for viewing your own 

profile, but also for viewing other profiles. This can be achieved as follows: 

1. Click on the menu in the upper left corner of Gutenberg Research 

Elements, which then opens.  

2. Click on the "Reporting" tab in the menu. 

3. Look in the category "Search".  

4. Click on the "Discovery Modules" link. It is the first link from the top 

in the "Search" category. 

5. Clicking on the "Discovery-Module" menu item will open the 

Research Profiles homepage in a new tab. 

However, Research Profiles can also be accessed via a path outside of Gutenberg 

Research Elements. For this, there is a link on the UB website that can be clicked on.  

Where does the data for Research Profiles come from? 

Research Profiles considers the Publications, Grants, Projects, and Professional 

Activities data areas from Gutenberg Research Elements. However, only profiles of 

researchers who have set their profile to "public" in Gutenberg Research Elements 

can be found.   
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How do I set my profile to "public" so I can use Research Profiles?  

Profile pages in Gutenberg Research Elements default to "internal" mode. This means 

that the profile page of a JGU researcher is not visible in Research Profiles, but only 

in Gutenberg Research Elements. A change option exists in the direction of "private" 

and "public". The setting "private" means that only the user himself can view his 

data. The setting "public" releases the profile page for Research Profiles, so that it 

can be viewed there and found by other researchers.  

Setting the profile page to "public" can be done as follows: 

1. Go to your profile page in Gutenberg Research Elements. You can do 

this by clicking on the people icon in the left margin. 

2. On the profile page, above the profile photo, there is a list indicating 

the visibility status of your profile page. It is possible to learn more 

about each visibility level or change the status here. 

3. To change the visibility status, click on "Switch to edit mode".  

4. In edit mode you will see which of the information you have provided 

is publicly visible in your profile, these are marked with "public" (e.g. 

phone number or email address, but also career information).  

5. To change the visibility, click on the "edit" button next to the respective 

information. Here you can change the information and set the visibility. 

Afterwards you have to save this ("save"). 

6. Alternatively, you can set your entire profile page to "private" so that it 

is no longer visible. This can be set above the profile picture in edit 

mode on the right side (at the position of the link into edit mode). In this 

case, none of the profile page information will be displayed in Research 

Profiles. 

 

Access & Registration  

Link to registration 

Research Profiles can be accessed at the following link: 

https://researchprofiles.uni-mainz.de/  

What information is displayed for visitors of Research Profiles?   

The profile page of a JGU researcher in Research Profiles consists of five tabs: 

"About", "Publications", "Research" and "Professional". The "About" tab is a view of 

the JGU researcher's personal information in Gutenberg Research Elements whose 

profile page is being viewed. This information represents biography, position at JGU, 

https://researchprofiles.uni-mainz.de/
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degrees, language skills, and subject areas. Videos can also be embedded in the 

profile page. 

On the left side is the name of the JGU researcher, their ORCID ID, phone number(s), 

mail address, work location, and link to social networks or a website. Publications are 

listed under "Publications", grants are listed under "Research", professional 

activities are listed under "Professional". 

What information can be seen in an entry of a publication in Research 

Profiles? 

An entry of a publication in Research Profiles shows publication type, title, publication 

date as well as co-authors. If a favorite status has been assigned to a publication, it 

can be seen in the upper right corner of the entry. In addition, it is possible to read the 

full text there - if it is accessible via Open Access as a PDF.  

If the full text of the publication is available in the Johannes Gutenberg University 

Open Access repository "Gutenberg Open Science", it can be viewed there. In 

Gutenberg Open Science you can also find information about publishing publications 

at the following link: https://openscience.ub.uni-mainz.de/help-faq.  

If the publication is not available in "Gutenberg Open Science", it can still be viewed. 

Clicking on the DOI will take you to the full text entry of the publisher of the publication. 

If the JGU researcher has a license to access the full text, he or she can also view 

and download it.  

Can the publications displayed in a user profile be sorted? 

Researchers using Research Profiles are able to choose in a selection field how they 

want to sort the displayed publications on their profile page. The publications can 

be sorted alphabetically in ascending or descending order, by year of publication 

in ascending or descending order, or by publication type. If a favourite status has 

been assigned for some publications, these can be displayed first in the publication 

list under the "favorites first" button. This is preset in case of a status assignment 

but can also be deactivated via the button. 

The selection field according to which criterion the results should be sorted can be 

found above the publication list.  

What information can be seen for Grants and Professional activities? 

The entries of the Grants show the respective title, the associated organization and 

the duration of the grant. The Professional activities entries show the title, the 

duration and the role of the JGU researcher.  
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How long does it take for changes made in Gutenberg Research Elements to 

be visible in Research Profiles? 

This varies by category. If changes are made by researchers to their own profile page 

in Gutenberg Research Elements, it only takes a few minutes for these to be visible 

in Research Profiles. If details are made to entries of objects such as publications, it 

may take longer for these to be seen in Research Profiles. This can be up to a week.  

Search 

What can I search for in Research Profiles?  

In Research Profiles, the profile pages of JGU researchers and their scientific work 

(Subject Areas) can currently be found.  

What search options are available in Research Profiles?  

In Research Profiles it is possible to search by the name of the JGU researcher, which 

can be found via the search slot. The search function can be set using a radio button 

located to the right of the search. There are two options. Either a free text search can 

be performed or a search can be performed using tags assigned by JGU researchers 

in Gutenberg Research Elements for their profile page. The tag-based search is 

particularly suitable for searching for the tags of the subject areas, in order to see 

which researchers are active in the searched areas and have published something. 

When searching for tags, similar tags are suggested and can be promoted by a click 

in the search field.  

Is it possible to sort the hit list? 

The hit list of a search for researchers at JGU can be sorted by relevance or by last 

name in ascending or descending alphabetical order.  

Which fields are searched for researchers in Research Profiles?  

If this information is provided in Gutenberg Research Elements, Research Profiles will 

search the fields Name, Overview, Research Interests, Teaching Summary, by 

Subject Area tags, Mailing Address, Department, Publication Titles, and Grant Titles. 

However, it is useful to search only for names of researchers at JGU and subject area 

tags.  

What information can be seen in a search result? 

The search result of a person search shows an excerpt of the profile page. In this 

excerpt, if specified, a profile picture, the name of the researcher at JGU, an excerpt 

of the overview and the tags of the DFG systematics can be seen. In addition, the 

match of the search query with the search results is displayed below a hit and in which 

category (e.g. name, biography, list of publications) the match exists. If media are 
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included in the profile page, they also appear in this excerpt and can be played, for 

example in the case of a video.  

Can I filter the hit list for researchers in Research Profiles?  

It is possible for the user of Research Profiles to filter the hit list of a search according 

to the subject areas. On the left side, you can select which results are available for 

the subject areas and display or hide them with a click. In addition, results that lack 

this information can also be displayed.  

What information is displayed for publications in Research Profiles?  

For publications, the publication date, the co-authors of the publication, the publication 

location and the DOI are displayed.  

Can the publications be accessed via Research Profiles?  

It is possible via the entry of a publication to access it via Research Profiles, provided 

that it is accessible via Open Access. This is possible in several ways:  

1. You can click directly on the PDF or on "View more info" to view the 

publication entry in the repository or.  

2. On the DOI, which also leads to the repository when clicked.  

What options do I have when I click on a hit in the search hit list? 

Clicking on a hit in the hit list will take you to the profile page of a researcher at JGU. 

In this view it is possible to see the publications, grants and professional activities (via 

the respective tabs), as well as the information about the JGU researcher (in the 

"About" tab).    

 


